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1 Safety Information

Before starting installation, setting up, operation and before 
maintenance work is carried out, it is essential to read and follow 
the appropriate warning and safety information given in this 
manual.

Installation, setting up, operation and maintenance of the mod-
ules or devices must take place as intended, i.e. under the condi-
tions of use laid down in this manual and in the technical data for 
the relevant module or device.

1.1 Intended use

The products in the Q.series range are intended for use in indus-
trial and experimental test engineering and for monitoring 
assembly and production processes. Transducers (sensors) for 
the acquisition of physical quantities such as voltage, current, 
resistance, temperature, force, displacement, torque, mass, 
strain and pressure can be connected. The modules are used 
exclusively for these kinds of measurement and control applica-
tions. Any application which goes beyond this scope does not fall 
within the intended use of the modules.

To ensure safe operation the modules and devices must only be 
operated according to the details given in the manuals and tech-
nical data sheets. In addition, the required legal and safety regu-
lations covering the respective application must be followed. This 
applies in particular to the modules A123, A124, A127 and A128 
with which input voltages of up to 1200 VDC can be used.

1.2 Checking for damage in transit

On receipt of the goods visually check that the packaging and the 
module or device together with the data medium are intact. Also 
check the shipment for completeness (accessory parts, documen-
tation, auxiliary aids, etc.). If the packaging has been damaged in 
transit or if you suspect that the product is damaged or may mal-
function, the product must not be put into operation. In this case 
contact your customer consultant or Gantner Instruments GmbH.

1.3 Personnel

The installation, operation and maintenance of the modules or 
devices must only be carried out by competent persons. Compe-
tent persons are those who through their professional education 
have sufficient knowledge in the required field and are familiar 
with the relevant national occupational protection regulations, 
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accident prevention regulations, guidelines and accepted engi-
neering rules. They must be able to reliably assess the results of 
their work and must be familiar with the contents of this manual.

Electrical connections must only be carried out by specialist per-
sonnel trained for the task.

In particular, pay attention to the following:

• the national installation and erection regulations (e.g. ÖVE, 
VDE, etc.)

• generally accepted engineering rules

• the details on transport, installation, operation, servicing, 
maintenance and disposal in this manual

• the parameters, limits and the details about the operating and 
ambient conditions on the name-plates and in the data sheets.

1.4 Special risks

The modules A123, A124, A127 and A128 are specially designed 
for measurements at high voltages. Consequently, on the mod-
ules a voltage of up to 1200 V may be present, which can lead to 
fatal or severe injury on touching the terminal contacts or bare 
parts of the connecting cables. Therefore, make sure that only 
qualified personnel have access to the modules or devices and 
that the voltages at modules can be switched off by a switch-dis-
connector or similar device for service purposes.

1.5 Siting locations

The devices in the Q.series range are protected to IP 20 against 
water, dirt and small parts. If the ambient conditions require it, 
the modules can be fitted in water-protected or watertight hous-
ings.

Please note the admissible ambient temperatures specified in the 
technical data.

1.6 Modifications

Making modifications to the modules or devices is not permitted. 
Dirt and shrouding covers may only be removed for service and 
maintenance purposes.

1.7 Servicing and cleaning

The modules or devices do not need any servicing. Cleaning may 
only take place in the voltage-free state. Therefore follow the 
points below:
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• Before cleaning, disconnect all connectors.

• Clean the housing with a soft, slightly moistened cloth. Never 
use any solvents, because these may attack the labels.

• When cleaning, make sure that no liquid enters into the 
device or goes onto the terminals.

Never attempt to repair nor to again operate devices which are 
defective, have developed a fault or are damaged. In this case it 
is essential to contact your customer consultant or Gantner 
Instruments GmbH.

1.8 Disposal

Old devices which are no longer usable must be disposed of 
according to national and local regulations regarding environ-
mental protection and raw-material recycling. Electronic compo-
nents must not be disposed of with the household refuse. The 
packaging can be recycled and should therefore be passed into 
the recycling system. However, we recommend that the packag-
ing is kept until the end of the warranty period so that you can 
pack faulty devices or modules properly.

1.9 General hazards due to non-observance of the 
safety information

The modules or devices conform to the state of the art and are 
operationally safe. However residual risks may arise when they 
are used and operated improperly by untrained personnel.

Any person commissioned with the task of siting, operating, ser-
vicing or repairing a module or device in the Q.series must have 
read and understood the operating manual and in particular the 
information relating to safety.
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2 Labels and Warning Infor-
mation

2.1 Warning information

To prevent personal injury and damage to property it is essential 
that you follow the warning and safety information given in this 
operating manual.

Indicates a directly threatening hazard. If it is not pre-
vented, the consequence will be fatal or serious injuries.

Indicates a possibly hazardous situation. If it is not prevented, the 
consequence may be fatal or serious injuries.

Indicates a possibly hazardous situation. If it is not prevented, the 
consequence may be injuries of slight or medium severity.

Indicates a situation in which the consequence may be property 
damage if the information is not followed.

2.2 Labels on the modules

Symbol: 

Meaning: This symbol is the CE marking. This shows that we 
guarantee that our product meets the requirements of the rele-
vant EC directives.

Symbol:  CAT I, CAT II, CAT III

Meaning: Modules with one of these symbols are intended for the 
connection of high voltage. The maximum admissible voltage is 
also given.
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Symbol: 

Meaning: Modules with this symbol may be connected to high 
voltages. Connection shall only be made with isolated connectors 
designated for these applications.

2.3 Labels in this manual

To simplify reading this manual we use the following labels and 
notation:

IMPORTANT
Paragraphs with this symbol give important information about 
the product or about using the product.

Tip
Contains application hints and other particularly useful informa-
tion.

italics signifies highlighted text

interface signifies entries and entry fields in program 
user interfaces

Options signifies menu items in the program user 
interfaces

> signifies a sequence of menu items, e.g. in 
Options > Settings

➡ indicates special features or restrictions
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3 Introduction
 Dear Customer,

Thank you for purchasing a product in the Q.series from Gantner 
Instruments GmbH. We are sure that you have obtained an excel-
lent product which will enable you to make fast and reliable mea-
surements with low measurement uncertainties.

The manual is included in the items supplied. Keep the manual 
safe or download the latest version from our web site. To prevent 
personal injury and damage to property it is essential that you fol-
low the warning and safety information given in this manual 
(Chapter 1, page 5). Please contact us if you do not know how to 
proceed even after reading the manual thoroughly.

If you find faults on the product or errors in the accompanying 
documentation or if you have suggestions for improvement, 
please contact your customer consultant or Gantner Instruments 
GmbH directly. We would be glad to receive your comments and 
ideas.

You will find further information in the section Technical Infor-
mation in our Wiki at https://dev.gantner-instruments.com/doku-
wiki. The user name is support and the password is gins (not all 
sections are open to the public). Alternatively, the Wiki from APP 
Instruments is also available to you: http://support.app-instru-
ments.com/dokuwiki, User name support, Password appins.
 

Austria Gantner Instruments GmbH

Montafonerstr. 4

6780 Schruns/Austria

Tel.: +43 (0) 55 56 774 63-0
Fax: +43 (0) 55 56 774 63-300

E-mail: office@gantner-instruments.com
Web: www.gantner-instruments.com

Germany Gantner Instruments Test & Measurement GmbH

Heidelberger Landstr. 74

64297 Darmstadt

Tel.: +49 (0) 6151 95136-0
Fax: +49 (0) 6151 95136-26

E-mail: testing@gantner-instruments.com
Web: www.gantner-instruments.com
 

https://dev.gantner-instruments.com/dokuwiki
https://dev.gantner-instruments.com/dokuwiki
mailto:office@gantner-instruments.com
http://www.gantner-instruments.com
mailto:testing@gantner-instruments.com
http://www.gantner-instruments.com
http://support.app-instruments.com/dokuwiki
http://support.app-instruments.com/dokuwiki
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3.1 The documentation for Q.bridge

The documentation for the Q.bridge consists of this manual about 
the Q.brixx modules A101, A102, A104, A106, A107, A108, A109, 
A116, A123, A124, A127, A128 and D101 as well as about the 
Q.bridge module.

You will find this manual also as a PDF file on our home page and 
on the Gantner CD enclosed with your system or which you can 
order free of charge from Gantner Instruments GmbH.

3.2 About this manual

This manual describes the installation, initial operation and the 
configuration of the modules Q.brixx A101, A102, A104, A106, 
A107, A108, A109, A116, A123, A124, A127, A128 and D101 with 
the Q.bridge module using the programs ICP 100, APPic Tool 
Suite and LabVIEW™ from National Instruments. The modules 
are differentiated through the number of their analog and/or dig-
ital inputs and outputs as well as by the maximum possible sam-
ple rate.

The manual is divided into several chapters:

• Safety information in Chapter 1, page 5ff.

• A description of the labels and symbols used on the modules 
and in this documentation can be found in Chapter 2 from 
page 9 onwards.

• You will find a description of the system and the main combi-
nation and expansion options in the next section.

• The description of the connection variants and the pin assign-
ments on the inputs and outputs can be found in Chapter 4, 
Connection, ff. page 15.

• A comprehensive introduction to the configuration of the 
modules using the program ICP 100 is given in Chapter 5, 
Configuration, ff. page 69.

• An introduction to the VIs for LabVIEW™ and an explanation 
of the example program for LabVIEW™ can be found in 
Chapter 6, LabVIEW™, page 83.

• Explanations of the module measurement technology and 
background information can be found in Chapter 7, Func-
tional Procedures, ff. page 95.
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3.3 System description

The modules in the Q.brixx series have been developed for indus-
trial and experimental measurement and test engineering, in par-
ticular for multi-channel measurements of electrical, mechanical 
and thermal signals on engine and component test-rigs as well as 
for monitoring processes and long-term supervision. The modules 
A123, A124, A127 and A128 are specially designed for measure-
ments at high voltages.

Voltages of up to 1200 V may be present on the connections 
of the modules A123, A124, A127 and A128.

Before connecting or disconnecting cables on these mod-
ules make sure that all sources of power are Locked Out.

The individual modules can be combined to form one system as 
required. You can connect up 16 modules to the Q.bridge module 
and then address them via a single interface.

On all modules the power supply, bus interface and the inputs 
and outputs are electrically isolated from one another.

Operating the modules via Q.bridge

The Q.bridge module has to be operated on the far left next to the 
Q.brixx modules (first slot). It must not be installed between the 
modules or to the right.

Abb. 3-1 Q.bridge with 8 modules.

Depending on the number and type of modules, transfer rates of, 
for example, 9 kHz per channel for four modules with a total of 24 
channels are possible:

max. 16 modules, here: 8 modulesQ.bridge
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The maximum overall sample rate is currently approx. 
220 kSamples per second.

Number of 
modules

Number of 
channels

Transfer rates (min) 
per channel

4 2 x 8 + 2 x 4 9 kHz

2 2 x 8 13 kHz

4 4 x 1 28 kHz

1 1 x 4 40 kHz

1 1 x 1 74 kHz
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4 Connection

This chapter contains the description of the connection variants 
and pin assignments.

4.1 Connecting the power supply

For the power supply an unregulated direct voltage between 10 
and 30 volts is required, which is connected to the socket right at 
the bottom in the Q.bridge module. Abb. 4-1 shows the pin 
assignment. Each module requires a power of approx. 2 W in 
addition to the power supplied for the connected transducers. 
The power required is almost constant over the complete voltage 
range.

Abb. 4-1 Pin assignment on the power supply socket.

IMPORTANT
When the modules are switched on, there is an increase current 
demand until the modules are operating in a stable manner: In 
the start-up phase up to 700 mA (10 ms) per module is needed 
depending on the supply voltage. Thereafter, you should expect 
approx. 500 mA per module for a 10 V supply voltage, with a 30 V 
supply voltage approx. 170 mA. You should therefore use power 
supply units which can supply the required peak power on 
switching on the voltage.

The modules have internal protection against brief excessive volt-
ages and currents and against short-term connection with incor-
rect polarity. 

➡ Do not use cable which is too thin for the connection so that the 
required power can be transferred to the module without signifi-
cant losses. 

Power supply +
(red marking, left pin)

Power supply –
(right pin)
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4.2 Connecting digital I/Os

The digital I/Os are accessible via the front panel. The table 
shows the terminal assignment on the Q.bridge.

4.3 Status and flashing sequences of the Q.bridge 
LEDs

Connec-
tion

Assign-
ment

Remarks

1 +V
External supply voltage for the digi-
tal outputs (12 V ... 30 V)

2 DOut 1 Low: Output active

3 DOut 2 Low: Output active

4 DOut 3 Low: Output active

5 DOut 4 Low: Output active

6 DIn 1 Low: Input active

7 DIn 2 Low: Input active

8 DIn 3 Low: Input active

9 DIn 4 Low: Input active

10 0 V I/O ground potential

1
0

1

Input

Din
6, 7, 8, 9

+V

10 (0 V)

Output

Dout
10 (0 V)

1

2, 3, 4, 5
+V

+V must be between 
12 V and 30 V

CFG (configuration)

Off
The Q.bridge is in the Measurement 
mode.

Flashing, approx. 0.5 s 
on and 0.5 s off (1 Hz) 
and LED MEAS is off

The Q.bridge is in the Transparent mode.

On
The Q.bridge is in the Configuration 
mode or a connection is established in 
the Transparent mode.

MEAS (Measurement)

Off
The Q.bridge is not in the Measurement 
mode.

Flashing, approx. 0.2 s 
on and 0.8 s off

The Q.bridge is in the Measurement 
mode but not yet initialized.
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Special cases

Boot sequence

RUN is continuously lit after switching on the power supply. Then 

STAT lights and goes out again, then MEAS lights and goes out again 
and finally CFG flashes to indicate that the Q.bridge is in the Trans-
parent mode.

➡ Refer also to Section 4.5, Module flashing frequency, page 21.

Flashing, approx. 0.8 s 
on and 0.2 s off

The Q.bridge is in the Measurement 
mode and initialized.

MEAS (Measurement)

Flashing, approx. 
50 ms on and 50 ms off

Error during initialization

On
The Q.bridge is in the Measurement 
mode.

STAT (Status)

On
The self-test is running which is carried 
out after switch-on.

RUN (power supply)

On The power supply is switched on.

Off There is no power supply present.

MEAS and CFG flashing 
alternately, each approx. 
0.1 s on and 0.1 s off

The modules are still booting and the 
Q.bridge is not ready.

MEAS flashes, approx. 
0.6 s on and 0.1 s off and 
CFG flashes, approx. 0.1 s 
on and 0.6 s off

One or more modules are using a baud 
rate different to the Q.bridge; refer to 
Section 4.4.4, page 21.

MEAS and CFG flash 3 
times short and 3 times 
long (SOS)

The system cannot be started. There is 
an error in the system or framework. If 
the error is still present after restart-
ing, please contact the Gantner sup-
port; refer to Chapter 8, International 
Sales and Service, page 105.
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4.4 Connecting Q.bridge to the PC via Ethernet

For communication (configuration and data interchange) with the 
modules you must connect the  Q.bridge module via Ethernet to a 
PC. Use a cross cable for the direct connection or connect the PC 
and Q.bridge using an Ethernet switch.

Tip
We recommend the use of cables to Cat-5e or better.

The Q.bridge module uses a permanent IP address: 192.168.1.23. 
With the program APPic Tool Suite you can set the IP address and 
subnet mask of the Q.bridge to a value suitable for your network. 
Alternatively, you can set your PC (at least temporarily) to an 
Ethernet address in the same network segment, i.e. the first 
three groups of numbers in the IP address must match. Refer to 
Section 7.1, Ethernet on the PC on page 95 for the display and 
setting of the PC IP address and subnet mask.

Tip
We recommend the use of industrial Ethernet switches. The 
Q.bridge module uses autonegotiation and operates, if available, 
with 100 Mbit/s and full duplex for the transmission.

4.4.1 Setting the Ethernet address (IP address) of the 
Q.bridge

Procedure

1. Make sure that the current version of the software APPic Tool 
Suite.exe is installed on your PC.

You will find the current version in the download section of 
our home page. If necessary, install the current version; refer 
to Section 5.1 on page 69.

2. Start the software.

3. Using the context menu Scan Network For Devices (click 
on an empty row in the table) start the search for the con-
nected Q.bridge.

4. You must have the appropriate access rights to be able to 
change the IP address: Menu File > Login.

5. Use user as the User name and user as thePassword.

The user name and password are used to prevent uninten-
tional changes. Changing the name or password is not neces-
sary and is also not intended.
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6. Mark the Q.bridge, the address of which is to be changed and 
via the context menu Configure Network Settings call up 
the dialog for changes.

7. Enter the required address at IP Address and click on Apply 
and Reboot.

If necessary, you can also change the subnet mask here. In 
the case of doubt, consult your network administrator.

8. Using the context menu Scan Network For Devices, start a 
new search. The Q.bridge module should now be shown with 
the new IP address.

Example

Chosen new IP address of the Q.bridge: 192.168.169.85
Possible PC IP address: 192.168.169.10
Subnet masks of the PC and module: 255.255.255.0

4.4.2 Displaying Q.bridge module information

Mark the Q.bridge in the list in the Real-Time Target Configura-
tor and select Show Device Info from the context menu. The fol-
lowing dialog contains information about the serial number, MAC 
address and the framework and application versions of the mod-
ule.

Using the context menu Show Installed Software, you obtain 
comprehensive information about the installed software modules.

4.4.3 The Q.series Viewer

The program APPic Tool Suite offers you the possibility of view-
ing the configuration of your system and of graphically displaying 
measurements from the modules.

Call the Q.series Viewer using the Q.bridge context menu Show 
in Q.series Viewer so that the correct IP address is already 
entered in the following window. If you call the viewer via the 
View menu, you must enter the correct address manually. Then 
click on Connect.

In the following window you see the connected modules with 
hardware and software versions as well as the channels present 
in the modules (Fig. 4-2).
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Abb. 4-2 Q.series Viewer, configuration view.

Using DataInput/Output, you can switch over to a graphical dis-
play showing up to four channels (Fig. 4-3). You select the chan-
nels to be displayed on the left side and click on Start. You can 
define the transfer parameters using Samplerate and Block-
size. In the Backlog field you can see how many values are in the 
output buffer. The value should be smaller than that for Block-
size and not larger, because otherwise the transfer takes place 
too slowly and values are lost if the buffer overflows.



Q.series
Gantner Instruments GmbH 21

4     Connection → Module flashing frequency

Abb. 4-3 Q.series Viewer, graphical display.

You can initiate the output of values after the start via Output 
Channel, Output Value and Update Output Value.

4.4.4 Setting the baud rate of the modules

The baud rate of the modules must be set to 12 MBd for the 
proper functioning of the Q.bridge. If the modules have been 
used elsewhere, e.g. in a Q.brixx system where a different baud 
rate was set, you have to change the baud rate.

Procedure

1. Call the Q.series Viewer (refer to Section 4.4.3).

2. Mark the relevant module.

3. Select Set Module Baud Rate from the context menu.

4. Set 12 MBd and click on Apply.

4.5 Module flashing frequency

The modules have three LEDs: one blue LED on the upper edge 
(A) and one red LED per connector strip (B and C). In normal 
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operation the blue LED lights when the module is addressed via 
LabVIEW™ or an application; otherwise the blue LED flashes. 
Normally, the red LEDs do not light. Depending on the error, the 
red LED of the affected connector strip or the blue LED lights or 
all LEDs flash in a certain order. In the following illustrations a 
short dash corresponds to short flash and a long dash to a long 
flash.

Refer also to Section 4.3, Status and flashing sequences of the 
Q.bridge LEDs, page 16.

4.5.1 SOS

Abb. 4-4 Flashing sequence with an incorrect module or when 
there are no settings in the base.

Cause: The configuration saved in the base does not match that in 
the module.

There may be two reasons for this:

1. There is no configuration in the base yet.

2. The module type saved in the base configuration differs from 
the plugged-in module, therefore the configuration cannot be 
accepted.

Consequently, either change the module for the correct module 
type or reconfigure the module (Chapter 5, Configuration, 
page 69). The (new) configuration is then automatically saved in 
the base.

4.5.2 Problems during data transmission

Abb. 4-5 Flashing sequence for problems during the data transmis-
sion.

These flashing sequences indicate a problem with the communi-
cation.

Restart the system (by switching off, waiting one minute and then 
switching on again). If these measures do not rectify the error, a 
hardware fault is probably present. Contact your customer con-
sultant or Gantner Instruments GmbH directly.

blue LED
red LED B

or



Q.series
Gantner Instruments GmbH 23

4     Connection → Module flashing frequency

4.5.3 LED displays in normal operation

For modules with analog inputs a red illuminated LED indicates 
that the measurement range has been exceeded on at least one 
input. You can suppress this indication in the module configura-
tion.

For modules with digital inputs or outputs an orange illuminated 
LED indicates that an input or output is active.
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4.6 The modules and their connection options

The following table gives you an overview of the various modules: 
sensor types that can be connected, signal outputs, the number of 
input channels, etc.
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4.7 Q.brixx A101: Connecting sensors and I/O

The Q.brixx Module A101 has two electrically isolated analog 
inputs and two digital inputs or outputs. The pin assignment of 
the two connector strips is identical and the connection terminals 
have numbers for identifying the connections.

GND identifies the measurement ground of an input, 0 V and +V 
refer to the (external) supply voltage connections. Measurement 
ground and (module) supply voltage are electrically isolated in 
the module.

Abb. 4-6 Pin assignment for Q.brixx Module A101.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 95.

 4.7.1 Voltage

With voltage measurements two connection variants are possible, 
depending on the level of the voltages to be measured: up to 10 V 
and up to 60 V.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Abb. 4-7 A101, measurement of voltage.

4.7.2 Current

A shunt resistance of 50  is integrated into the Q.brixx Module 
A101 for current measurement. This facilitates the measurement 
of currents of up to 25 mA. For higher currents use a voltage mea-
surement and an external shunt; refer to Section 7.4, page 103.

Abb. 4-8 A101, measurement of current.

4.7.3 Potentiometer

Potentiometers with resistances between 1 k and 10 k are con-
nected in a three-wire configuration.

Abb. 4-9 A101, measurement with potentiometers.

4.7.4 Resistance, Pt100, Pt1000

You can connect resistances and Pt100/1000 probes in two-wire 
or four-wire circuits. You specify the selected type of circuit 
during the module configuration (Type column).

Abb. 4-10 A101, measurement of resistance and Pt100/1000 probes.
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Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 7.2, Connecting 
sensors with sensing leads, page 100.

4.7.5 Thermocouple

For connecting thermocouples you need a special connecting 
plug which contains the comparative measuring point (cold point 
compensation) required for thermocouples. The plug can be 
obtained under the designation Q.bloxx Terminal CJC-A101 from 
Gantner Instruments GmbH. You can connect the following types 
of thermocouple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 7.5, Measuring with thermocouples, page 104.

Abb. 4-11 A101, measurement with thermocouple using Q.bloxx 
Terminal CJC-A101.

4.7.6 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) all connec-
tions are occupied. If the sensor has no sensing leads, you specify 
this during the module configuration (Type column). With half 
bridges the side drawn in dashes and the connection 5 are omit-
ted.

The bridge excitation voltage is 2.5 V. 
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Abb. 4-12 A101, measurement with full and half bridges.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 7.2, Connecting 
sensors with sensing leads, page 100.

4.7.7 Strain-gauge quarter bridges

For the connection of strain-gauge quarter bridges you need a 
special connecting plug which contains the completion resis-
tances. The plug can be obtained under the designation Q.bloxx 
Terminal B4/120-A101 with120  or B4/350-A101 with 350  from 
Gantner Instruments GmbH.

The bridge excitation voltage is 2.5 V.

IMPORTANT
The plug must have the same resistance values as the strain 
gauges used, because otherwise no measurement is possible.
Since, for reasons of stability, all necessary completion resis-
tances are located in the Q.bloxx Terminal, you have to select a 
full bridge circuit as the bridge type for the channel.

Abb. 4-13 A101, measurement with strain-gauge quarter bridge 
using Q.bloxx Terminal B4.

4.7.8 IEPE/ICP® sensor

The sensor is supplied with 4 mA of current from the module (cur-
rent supply).

4
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Abb. 4-14 A101, measurement with IEPE or ICP® sensors.

4.7.9 Digital input and output

On each connecting plug a contact is available for an input or out-
put. You can use the appropriate function depending on the wir-
ing.

Abb. 4-15 A101, digital input and output.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.
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4.8 Q.brixx A102: Connecting sensors and I/O

The Q.brixx Module A102 has one electrically isolated analog 
input, one analog output and two digital inputs or outputs electri-
cally isolated from the analog section. The assignment of both 
connector strips is not identical. The plug number is specified in 
the following. The connection terminals have numbers for identi-
fying the connections.

GND identifies the measurement ground of an input, 0 V and +V 
refer to the (external) supply voltage connections. Measurement 
ground and (module) supply voltage are electrically isolated in 
the module.

Abb. 4-16 Pin assignment for Q.brixx Module A102.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 95.

 4.8.1 Voltage

You can measure voltages of up to 10 V via Plug 2.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Abb. 4-17 A102, measurement of voltage, Plug 2.

4.8.2 Current

A shunt resistance of 50  is integrated into the Q.brixx Module 
A102 for current measurement. This facilitates the measurement 
of currents of up to 25 mA via Plug 2. For higher currents use a 
voltage measurement and an external shunt; refer to Section 7.4, 
page 103.

Abb. 4-18 A102, measurement of current, Plug 2.

4.8.3 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) all connec-
tions are occupied. If the sensor has no sensing leads, you specify 
this during the module configuration (Type column). With half 
bridges the side drawn in dashes and the connection 4 are omit-
ted.

The bridge excitation voltage is switched via software between 
1 V, 2.5 V, 5 V and 10 V. 

Abb. 4-19 A102, measurement with full and half bridges, Plug 2.
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Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 7.2, Connecting 
sensors with sensing leads, page 100.

4.8.4 Strain-gauge quarter bridges

For the connection of strain-gauge quarter bridges you need a 
special connecting plug which contains the completion resis-
tances. The plug can be obtained under the designation Q.bloxx 
Terminal B4/120-A102 with120  or B4/350-A102 with 350  from 
Gantner Instruments GmbH.

The bridge excitation voltage is switched via software between 
1 V, 2.5 V, 5 V and 10 V. 

IMPORTANT
The plug must have the same resistance values as the strain 
gauges used, because otherwise no measurement is possible.
Since, for reasons of stability, all necessary completion resis-
tances are located in the , you have to select a full bridge circuit 
as the bridge type for the channel.

Abb. 4-20 A102, measurement with strain-gauge quarter bridge 
using Q.bloxx Terminal B4 on Plug 2.

4.8.5 IEPE/ICP® sensor

The sensor is supplied with 4 mA of current from the module (cur-
rent supply).

Abb. 4-21 A102, measurement with IEPE and ICP® sensors, Plug 2.

4.8.6 Analog output

An analog output for voltage or current is available on Plug 1. The 
selection between voltage and current is made via software.
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Abb. 4-22 A102, output of voltage or current, Plug 1.

4.8.7 Digital input and output

Contacts for four inputs and two outputs are available on Plug 1.

Abb. 4-23 A102, digital input and output, Plug 1.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.
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4.9 Q.brixx A104: Connecting sensors

The Q.brixx Module A104 has eight electrically isolated analog 
inputs for thermocouples or voltages. The pin assignment of the 
two connector strips is identical and the connection terminals 
have numbers for identifying the connections. If several connec-
tions are possible, you will find the associated ones in each case 
at the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method.

The module can also be obtained with other connections, e.g. 
with Mini TKC sockets. In this variant no Q.bloxx Terminal CJC-
A104 is needed.

Tip
To secure the thermocouple plug-in connector against falling out, 
perforated metal nipples are fitted over the sockets in the version 
with TKC sockets. After inserting all thermocouple plug-in con-
nectors, insert, for example, a wire through the holes in the plugs 
and the metal nipples and twist the ends of the wire.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Abb. 4-24 Pin assignment for Q.brixx Module A104 (left), version 
with Mini TKC sockets on the right side.
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Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 95.

 
4.9.1 Voltage

You can measure voltages of up to 80 mV.

IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Abb. 4-25 A104, voltage measurement.

4.9.2 Thermocouple

For connecting thermocouples you need a special connecting 
plug which contains the comparative measuring point (cold junc-
tion compensation) required for thermocouples. The plug can be 
obtained under the designation Q.bloxx Terminal CJC-A104 from 
Gantner Instruments GmbH. You can connect the following types 
of thermocouple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 7.5, Measuring with thermocouples, page 104.

Abb. 4-26 A104, measurement with thermocouple using Q.bloxx 
Terminal CJC-A104.
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4.10 Q.brixx A106: Connecting sensors and I/O

The Q.brixx Module A106 has two electrically isolated analog 
inputs, two analog outputs and four digital inputs and outputs. 
The pin assignment of the two connector strips is identical and 
the connection terminals have numbers for identifying the con-
nections.

GND identifies the analog and the measurement ground, 0 V and 
+V refer to the (external) supply voltage connections. Measure-
ment ground/GND and (module) supply voltage are electrically 
isolated in the module. The measurement ground for input and 
the analog ground (output) are identical.

Abb. 4-27 Pin assignment for Q.brixx Module A106.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 95.

 4.10.1 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) all connec-
tions are occupied. If the sensor has no sensing leads, you specify 
this during the module configuration (Type column). With half 
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bridges the side drawn in broken lines and the connection 10 are 
omitted.

The bridge excitation voltage can be 2.5 V or 5 V (DC or CF).

Abb. 4-28 A106, measurement with full and half bridges.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 7.2, Connecting 
sensors with sensing leads, page 100.

4.10.2 Strain-gauge quarter bridge

For the connection of strain-gauge quarter bridges you need a 
special connecting plug which contains the completion resis-
tances. The plug can be obtained under the designation Q.bloxx 
Terminal B4/120-A106 with120  or B4/350-A106 with 350  from 
Gantner Instruments GmbH.

The bridge excitation voltage can be 2.5 V or 5 V (DC or CF).

IMPORTANT
The plug must have the same resistance values as the strain 
gauges used, because otherwise no measurement is possible.
Select a half-bridge circuit as the type of bridge for the channel.

Abb. 4-29 A106, measurement with strain-gauge quarter bridge 
using Q.bloxx Terminal B4.

4.10.3 Inductive full and half bridges

With inductive full bridges all connections are occupied. If the 
sensor has no sensing leads, you specify this during the module 
configuration (Type column). With half bridges the side drawn in 
broken lines and the connection 10 are omitted.
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The bridge excitation voltage can be 2.5 V or 5 V.

IMPORTANT
During the configuration set CF 4800 Hz (carrier frequency) in 
the Type column; inductive sensors cannot be operated with 
direct voltage (DC) or 600 Hz carrier frequency.

Abb. 4-30 A106, measurement with inductive full and half bridges.

4.10.4 LVDT, RVDT

With (inductive) LVDTs or RVDTs all connections can be occu-
pied, but you can also connect without sense leads and state this 
in the Type column when configuring the module.

The bridge excitation voltage can be 2.5 V or 5 V.

IMPORTANT
During the configuration set CF 4800 Hz (carrier frequency) in 
the Type column; inductive sensors cannot be operated with 
direct voltage (DC) or 600 Hz carrier frequency.

Abb. 4-31 A106, measurement with LVDTs and RVDTs.

4.10.5 Analog output

An analog voltage output is available on each connecting plug.
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Abb. 4-32 A106, analog output.

4.10.6 Digital input and output

On each connecting plug two contacts are available for an input 
or output. You can use the appropriate function depending on the 
wiring.

Abb. 4-33 A106, Digital Input and Output.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.
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4.11 Q.brixx A107: Connecting sensors

The Q.brixx Module A 107 has four electrically isolated analog 
inputs. The pin assignment of the two connector strips is identical 
and the connection terminals have numbers for identifying the 
connections. If several connections are possible, you will find the 
associated ones in each case at the same place in the circuit dia-
grams, for example each of the figures quoted in the second place 
belong to one possible connection method.

GND identifies the measurement ground. The four inputs (UF to 
GND) are electrically isolated in the module one to the other and 
to the (module) supply voltage.

Abb. 4-34 Pin assignment for Q.brixx Module A107 (terminal ver-
sion).

The module can also be obtained in a connection variant with 
four 9-pole D-sub sockets (A107 DB9, refer to Abb. 4-35). With 
this version the module power supply (+V and 0 V) is available on 
the D-sub sockets. GND identifies the measurement ground. The 
four inputs are electrically isolated in the module one to the other 
and to the (module) supply voltage.
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Abb. 4-35 Pin assignment for Q.brixx Module A107, version with D-
sub sockets.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 95.

4.11.1 Voltage

You can measure voltages of up to 10 V.

IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Abb. 4-36 A107, measurement of voltage: left: terminal version; 
right: D-sub sockets.
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4.11.2 Current

A shunt resistance of 50  is integrated into the Q.brixx Module 
A107 for current measurement. This facilitates the measurement 
of currents of up to 25 mA. For higher currents use a voltage mea-
surement and an external shunt; refer to Section 7.4, page 103.

Abb. 4-37 A107, measurement of current; left: terminal version; 
right: D-sub sockets.

4.11.3 Potentiometer

Potentiometers with resistances between 1 kOhm and 10 kOhm 
are connected in a three-wire configuration.

Abb. 4-38 A107, measurement with potentiometers; left: terminal 
version; right: D-sub sockets.

4.11.4 Resistance, Pt100, Pt1000

You can connect resistances and Pt100/1000 probes in two-wire 
or four-wire circuits. You specify the selected type of circuit 
during the module configuration (Type column).

Abb. 4-39 A107, measurement of resistance and Pt100/1000 probes; 
left: terminal version; right: D-sub sockets.
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Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 7.2, Connecting 
sensors with sensing leads, page 100.

4.11.5 Thermocouple (only with terminal version)

For connecting thermocouples you need a special connecting 
plug which contains the comparative measuring point (cold junc-
tion compensation) required for thermocouples. The plug can be 
obtained under the designation Q.bloxx Terminal CJC-A107 from 
Gantner Instruments GmbH. You can connect the following types 
of thermocouple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 7.5, Measuring with thermocouples, page 104.

Abb. 4-40 A107, measurement with thermocouple using Q.bloxx 
Terminal CJC-A107.

4.11.6 Full-bridge transducer

With (resistive) full bridges (strain-gauge full bridges) four con-
nections are occupied. If the sensor has sense leads, you should 
connect them to the relevant supply lines: in the terminal version 
to terminals 1 and 5 or 6 and 10, with D-sub sockets to pins 1 and 
8.

The bridge excitation voltage is 2.5 V. 
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Abb. 4-41 A107, measurement with full bridge; left: terminal ver-
sion; right: D-sub socket.

4.11.7 Strain-gauge half and quarter bridges

For the connection of strain-gauge half or quarter bridges you 
need a special connecting plug which contains the completion 
resistances. The plug for the terminal version can be obtained 
under the designation Q.bloxx Terminal B4/120-A107 with120  
or B4/350-A107 with 350  from Gantner Instruments GmbH. An 
adapter plug is available for the version with D-sub sockets 
(Abb. 4-42).

Abb. 4-42 Adapter plug for D-sub version.

The bridge excitation voltage is 2.5 V.

IMPORTANT
For strain-gauge quarter bridges the plug or the terminal must 
have the same resistance values as the strain gauges used, 
because otherwise no measurement is possible.
Since, for reasons of stability, all necessary completion resis-
tances are located in the Q.bloxx terminal, you always have to 
select a full bridge circuit as the bridge type for the channel.
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Abb. 4-43 A107, measurement with strain-gauge half bridge and 
quarter bridge using Q.bloxx Terminal B4 (terminal ver-
sion).

Abb. 4-44 A107, measurement with strain-gauge half bridge and 
quarter bridge through adapter plug on the version with 
D-sub sockets.
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4.12 Q.brixx A108: Connecting sensors and I/O

The Q.brixx Module A108 has eight electrically isolated analog 
inputs and two digital inputs and outputs. The pin assignment of 
the two connector strips is identical and the connection terminals 
have numbers for identifying the connections. If several connec-
tions are possible, you will find the associated ones in each case 
at the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method.

The module is also available in the connection variant with eight 
BNC sockets (A108 BNC).

The designations 0 V and +V refer to the (external) supply volt-
age connections. Measurement ground (–) and the (module) sup-
ply voltage are electrically isolated in the module.

Abb. 4-45 Pin assignment for Q.brixx Module A108 (left), version 
with BNC sockets on the right side.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 95.
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4.12.1 Voltage

You can measure voltages of up to 10 V.

IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Abb. 4-46 A108, voltage measurement (terminal version); in the ver-
sion with BNC sockets the (inner) pin contact has to be 
connected to +. The outer conductor is connected to –.

4.12.2 Current

For current measurement you need the Q.bloxx Terminal SR con-
necting plug containing the shunt resistances for the terminal 
version. This facilitates the measurement of currents of up to 
25 mA.In the version with BNC sockets you must use a suitable 
shunt resistance and determine the current from the voltage drop 
and the resistance value of the shunt. The connection is made as 
for the voltage measurement.

Abb. 4-47 A108, current measurement using the Q.bloxx Terminal 
SR.

4.12.3 Digital input and output

On each connecting plug of the terminal version two contacts are 
available in each case for one input and one output.

Abb. 4-48 A108, digital input and output.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.
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4.13 Q.brixx A109: Connecting I/O and outputs

The Q.brixx Module A109 has four electrically isolated analog 
outputs, four digital inputs and four digital outputs. The assign-
ment of both connector strips is not identical. The plug number is 
specified in the following. The connection terminals have num-
bers for identifying the connections. If several connections are 
possible, you will find the associated ones in each case at the 
same place in the circuit diagrams, for example each of the fig-
ures quoted in the second place belong to one possible connec-
tion method.

The designations 0 V and +V refer to the (external) supply volt-
age connections, NC indicates “not assigned”. Analog ground (–) 
and the (external) supply voltage (0 V) are electrically isolated in 
the module.

Abb. 4-49 Pin assignment for Q.brixx Module A109.

 4.13.1 Digital input and output, Plug 1

On Plug 1 contacts for four inputs and four outputs are available. 
Since the inputs and outputs of this module are electrically iso-
lated from the supply voltage, you must also connect 0 V for the 
inputs and 0 V and a supply voltage (+V) for the outputs.
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Abb. 4-50 A109, digital input and output, Plug 1.

The digital input is active (high level) when the applied signal 
voltage lies above the (programmable) threshold.

Possible combinations of contact assignments for the inputs are 
shown in the following table; refer also to the block diagrams for 
Module D101.

1) e.g. counter with additional input for counting direction 
or 2-phase counter signals or frequency measurement 
with direction detection (torque transducers)

2) e.g. counter with additional inputs for counting direction, 
zero reference and reset/enable for zero reference

4.13.2 Analog output, Plug 2

The analog outputs on Plug 2 supply voltage or current. Selection 
is made via software.

Abb. 4-51 A109, output of voltage or current, Plug 2
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4.14 Q.brixx A116: Connecting sensors

The Q.brixx Module A116 has eight analog inputs.

The channels (measurement ground) are electrically isolated 
against the (module) supply voltage and the interface.

Abb. 4-52 Pin assignment for Q.brixx Module A116.

4.14.1 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) six connec-
tions are used per measuring point. If the sensor has no sensing 
leads, you specify this during the module configuration (Type col-
umn); the USen inputs then remain open. With half bridges the 

side drawn in dashes and the USig- connection are omitted.

The bridge excitation voltage is 2 VDC; with 350  sensor resis-

tance you can also use 4 VDC. The internal shunt resistance can 

be activated also with full and half bridges.
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Abb. 4-53 A116, measurement with full and half bridges; USIG = sig-

nal voltage (output signal), USEN = sense lead, UEXC = 

excitation voltage

For the activation of the shunt resistance refer to Section 4.14.3.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 7.2, Connecting 
sensors with sensing leads, page 100.

4.14.2 Strain-gauge quarter bridge

With this module, for the connection of strain-gauge quarter 
bridges you do not need any special connection plugs as the 120  
and 350  completion resistances are present in the module and 
only need to be activated. In addition you can activate the inter-
nal shunt resistance for test purposes.

The bridge excitation voltage is 2 VDC; with 350  sensor resis-

tance you can also use 4 VDC.

Abb. 4-54 A116, measurement with a strain-gauge quarter bridge, 
direct connection.

For the activation of the shunt resistance refer to Section 4.14.3.

With the three-wire circuit the internal completion resistance is 
used in this module to determine the voltage drop over the cable 
and to correct the result accordingly. In this way not only can the 
influence of the temperature on the cable (normal three-wire cir-
cuit) be compensated, but also the loss of sensitivity due to the 
cable resistance over a wide range.
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4.14.3 Activating the shunt resistance

You can activate the shunt both via a variable and manually via a 
button.

Open the module settings dialog(Fig. 4-55), activate the tab Vari-
able definition and click in the column Format/balance. The 
dialog of Fig. 4-56 opens.

Abb. 4-55 Module configuration dialog.

Abb. 4-56 Dialog for format settings.

Abb. 4-57 Dialog for shunt activation.

Manual activation

Define the Direction for the variable on Input/output (Fig. 4-
56) and click on Shunt cal. Activate Control computer in the 
dialog (Fig. 4-57).

Setting a value of 16 for the variable (the channel) activates the 
shunt and 0 deactivates it again.
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Activation via variable

Click on Shunt cal. Activate At variable value in the dialog 
(Fig. 4-57) and specify the variable to be used.

Any variable value > 0.5 activates the shunt.
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4.15 Q.brixx A123: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.brixx module A123 can be used in the categories CAT II up 
to 1000 V and CAT III up to 600 V and has four electrically iso-
lated analog inputs.

With this module the connection is provided through four BNC 
sockets. The outer side of the BNC sockets is isolated and the 
electrical connection is made through the inner side of the 
socket.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Abb. 4-58 Pin assignment for Q.brixx Module A123.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 95.
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 4.15.1 Voltage

You can measure voltage differences of up to ±10 V. The voltage 
level (the potential) may be up to 1200 VDC.

IMPORTANT
Voltage differences which exceed the admissible limits produce 
incorrect measurement data, because the inputs are protected 
against overvoltages and limit the input voltage.

Abb. 4-59 A123, voltage measurement.

4.15.2 Current

You need an (external) shunt resistance for the current measure-
ment.

Abb. 4-60 A123, current measurement using an external shunt 
resistance.
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4.16 Q.brixx A124: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.brixx module A124 can be used in the categories CAT II up 
to 1000 V and CAT III up to 600 V and has four electrically iso-
lated analog inputs for thermocouples. The terminal assignment 
is identical and the connection terminals have numbers for iden-
tifying the connections. 

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module. The plugs for the A124 module 
are 2-way plugs with push-in spring technology, i.e. you can 
insert a solid wire or a fine-stranded wire with a wire-end sleeve 
directly without screwing. The plugs are permanently joined to 
the housing and cannot be removed. With a screwdriver press on 
the white opener to be able to remove the connection -

Abb. 4-61 Pin assignment for Q.brixx Module A124.
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Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 95.

 
4.16.1 Voltage

You can measure voltage differences of up to ±80 mV. The volt-
age level (the potential) may be up to 1200 VDC.

IMPORTANT
Voltage differences which exceed the admissible limits produce 
incorrect measurement data, because the inputs are protected 
against overvoltages and limit the input voltage.

Abb. 4-62 A124, voltage measurement.

4.16.2 Thermocouple

Thermocouples can be connected directly; the comparative mea-
suring point (cold junction compensation) is integrated in the 
module plug. You can connect the following types of thermocou-
ple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 7.5, Measuring with thermocouples, page 104.

Abb. 4-63 A124, measurement with a thermocouple.

U
AIn+

AIn –

AIn –

AIn +



Q.series
Gantner Instruments GmbH 59

4     Connection → Q.brixx A127: Connecting sensors

4.17 Q.brixx A127: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.brixx module A127 can be used in the categories CAT II up 
to 1000 V and CAT III up to 600 V and has four electrically iso-
lated analog inputs. 

With this module the connection is provided through four BNC 
sockets. The outer side of the BNC sockets is isolated and the 
electrical connection is made through the inner side of the 
socket.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Abb. 4-64 Pin assignment for Q.brixx Module A127.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 95.

U
AIn +

AIn –

I Rext.

AIn +

AIn -

AIn 1+

AIn 1–

AIn 2+

AIn 2–

AIn 3+

AIn 3–

AIn 4+

AIn 4–
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 4.17.1 Voltage

You can measure voltage differences of up to ±1200 V. Here, var-
ious input voltage ranges from ±40 VDC to ±1200 VDC are possi-

ble. The voltage level (the potential) may be up to 1200 VDC.

Voltages above 1200 V can damage the module.

Each module is tested with a test voltage of 5 kVDC for one min-

ute. A longer duration or a higher voltage can damage the mod-
ule. In addition, each period of overvoltage reduces the service 
life of the module.

Abb. 4-65 A127, measurement of voltage.

IMPORTANT
Voltages which exceed the admissible limits give incorrect mea-
surement data, because the input voltage is internally limited.

4.17.2 Current

Confusing the current and voltage inputs can damage the module 
and/or the external load resistance.

Make sure that no high voltages are applied to the current inputs. 
The voltage drop must not be beyond ±2.4 V.

You need an (external) shunt resistance for the current measure-
ment.

Abb. 4-66 A127, current measurement using an external shunt 
resistance.

U
AIn +

AIn –

I Rext.

AIn +

AIn –
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4.18 Q.brixx A128: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.brixx module A128 can be used in the categories CAT II up 
to 1000 V and CAT III up to 600 V and has four electrically iso-
lated analog inputs.

With this module the connection is provided through four BNC 
sockets. The outer side of the BNC sockets is isolated and the 
electrical connection is made through the inner side of the 
socket.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Abb. 4-67 Pin assignment for Q.brixx Module A128.

Tip
Further information on transducers and sensors can also be 
found in Chapter 7 ff. page 95.
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 4.18.1 Voltage

You can measure voltages of up to ±1200 VDC. Here, various 

input voltage ranges from ±40 VDC to ±1200 VDC are possible.

Voltages above 1200 V can damage the module.

Each module is tested with a test voltage of 5 kVDC for one min-

ute. A longer duration or a higher voltage can damage the mod-
ule. In addition, each period of overvoltage reduces the service 
life of the module.

Abb. 4-68 A124, voltage measurement.

IMPORTANT
Voltages which exceed the admissible limits give incorrect mea-
surement data, because the input voltage is internally limited.

U
AIn +

AIn –
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4.19 Q.brixx D101: Connecting I/O

The Q.brixx Module D101 has eight digital inputs and eight digi-
tal outputs. The pin assignment of the two connector strips is 
identical and the connection terminals have numbers for identify-
ing the connections.

The designations 0 V and +V refer to the (external) supply volt-
age connections.

Abb. 4-69 Pin assignment for Q.brixx Module D101.

 4.19.1 Digital input and output

On each connecting plug contacts for four inputs and four out-
puts are available. Since the inputs and outputs of this module 
are electrically isolated from the supply voltage, you must also 
connect 0V for the inputs and 0 V and a supply voltage (+V) for 
the outputs.

Abb. 4-70 D101, digital input and output.
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The digital input is active (high level) when the applied signal 
voltage lies above the (programmable) threshold.

The following table shows possible combinations of contact 
assignments for the inputs:

1) e.g. counter with additional input for counting direction or 2-phase counter signals or fre-
quency measurement with direction detection (torque transducers)

2) e.g. counter with additional inputs for counting direction, zero reference and reset/enable 
for zero reference

3) e.g. sensors with binary coding

The following block diagrams give you an overview of the possi-
ble circuits.

Measurement of status, time, frequency or PWM 
(Pulse-Width Modulation), 1 signal

 Plug.Contact

 1.6 1.7 1.8 1.9 2.6 2.7 2.8 2.9

Status Status Status Status Status Status Status Status

Status Status Status Status Status Status 2-channel signal1)

Status Status Status Status 2-channel signal1) 2-channel signal1)

Status Status Status Status 4-channel signal2)

Status Status 2-channel signal1) 2-channel signal1) 2-channel signal1)

Status Status 2-channel signal1) 4-channel signal2)

2-channel signal1) 2-channel signal1) 4-channel signal2)

2-channel signal1) 2-channel signal1) 2-channel signal1) 2-channel signal1)

4-channel signal2) 4-channel signal2)

8-channel signal3)

Din
0V
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Up/down counter or measurement of frequency and direction with 

static direction signal, 2 signals

Measurement of frequency and direction or up/down counter with 

2-channel frequency signal (90° phase delay)

Measurement of frequency and direction or up/down counter with 

4-channel frequency signal

Din

+/-

0V

Din

0V

Din

Index

Index 
enable

0V
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4.20 Q.brixx S104: Supply Module

The Q.brixx Module S104 is used for supplying active sensors or 
other peripherals and provides four electrically isolated supply 
voltages on two connector strips: 5 VDC, 12 VDC, 15 VDC and 

24 VDC. The output power is 5 W per voltage. The assignment of 

the two connector strips is identical and the contacts of the first 
connection terminal are connected to the same type of contacts 
on the second connection terminal. The connection terminals 
have numbers for identifying the connections.

GND identifies the ground connection (0 V) of a supply voltage 
and the corresponding supply voltage is stated after it in brack-
ets. NC signifies “No Connection”.

Abb. 4-71 Pin assignment for Q.brixx Module S104.
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4.21 Replacing a module

Since the configuration of a module is also saved in the base of 
the module which is permanently connected to the rear panel of 
the Q.brixx system, you can easily replace one module by another 
one of the same type, e.g. if you want to use a module with differ-
ent connections (D-sub or thermocouple sockets).

Since the module configuration is also stored in the module base, 
it is sufficient to just replace the module. The configuration pres-
ent in the base is automatically transferred into the module when 
the power supply is switched on.

Procedure for replacement

1. Switch off the power supply to the Q.brixx system.

2. Release the screws of the module at the front of the Q.brixx 
system (refer to red marking in Fig. 4-72) with a cross-tip 
screwdriver.

3. Withdraw the module towards the front.

4. Push in the new module from the front (note the guiding 
grooves).

5. Retighten the module screws.

6. Switch on the power supply to the Q.brixx system.

The module will now be configured from the base (flashing 
LEDs). When LEDs cease to flash, the configuration is con-
cluded and the module is ready for operation.

Abb. 4-72 To remove a module release the screws in the red circles.
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4.22 Replacing/changing the module type

If you are using a different type of module, the configuration is 
not loaded from the module base, because a different module 
type is involved.

The procedure is initially described in Section 4.22. Accordingly, 
you have to transfer the current or a new configuration into the 
base.

Transferring the configuration to the base

On saving a configuration, e.g. with the ICP 100 program or the 
test.commander program, the (new) configuration is automati-
cally transferred into the base. In this way it is ensured that the 
same configurations are always present both in the base and in 
the module.

4.23 Adding modules to or removing them from the 
system

A change in the number of modules can only be made by Gantner; 
for this please contact the support; refer to Chapter 7, Functional 
Procedures, page 95.
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5 Configuration

You can only configure the modules with the ICP 100 graphically 
guided configuration software (from version 3.2.21).

5.1 Configuration via ICP 100

For the program a license number is needed which you have to 
enter to be able to save configurations. If you have installed the 
Gantner test.commander software, the ICP 100 software is also 
installed and is released when test.commander is licensed. You 
will find the license numbers in the PDF file enclosed with the 
supplied items and on the separate printout with your license 
data.

Basic procedure

• Start the program.

• Define the communication parameters and establish the con-
nection (communication) between the PC and Q.bridge; refer 
to Section 5.1.2, page 70.

• Enter the sensors used and their sensitivities to obtain an 
indication in the measured physical quantity.

• Define computations, digital inputs/outputs, alarm monitor-
ing, etc.

• Activate all settings in the modules.

Tip
At many points in the programs you can call the setting dialogs or 
settings via the context menu of an entry. You call the context 
menu with the right mouse key.

If you already have a configuration file with the required settings 
available, you can load this file into the relevant module with the 
program ICP 100.

5.1.1 Installing the ICP 100

➡ We recommend that you close all open programs before the 
installation.

Insert the Gantner CD into your CD drive. In the standard config-
uration Windows opens the CD automatically and a start window 
appears. If you have deactivated the Windows autostart function, 
find the file StartUp.exe in the main directory on the CD and give 
the corresponding symbol a double click to obtain the start win-
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dow. Alternatively, you can also start the program Setup.exe in 
the folder ICP100 to carry out the installation directly.

You will also find the relevant latest versions of the programs on 
our home page www.gantner-instruments.com via Software > 
Download.

Procedure • Click on the symbol over Load software.

• Click on the symbol  next to the program which you 

want to install.

The program Setup.exe is started.

• Allow the file to open so that the installation can start.

The starting dialog of the setup program appears. 

• Follow the instructions of the setup program to define the 
installation directory and the program group for the software.

Setup.exe creates the directory you have specified, if neces-
sary and then copies all files to it.

When the program  is started for the first time, you specify the 
language for the program user interface (you can change your 
selection at any time via Utilities > Settings > Language). 

Then enter your license data via Help > Info and Licensing. If 
you have licensed the program test.commander, then the pro-
gram ICP 100 is also enabled and a further license is not 
required.

5.1.2 Setting communication parameters, establishing con-
nection

To be able to connect to the Q.bridge it must be in the Transpar-
ent mode. You can check this with the LEDs on the Q.bridge: 
RUN is on, MEAS is off and CFG flashes at approx. 1 Hz. Refer also 
to Section 4.3, Status and flashing sequences of the Q.bridge 
LEDs, page 16. If necessary, switch the Q.bridge off and then on 
again (withdraw power supply plug and insert it again).

Once you have connected the PC to the Q.bridge via Ethernet and 
have started the ICP 100 program, you have to specify in the pro-
gram the interface to be used.

1. Select Communication > Parameters.

2. Specify the interface for the connection: TCP/IP Base (Fig. 5-
1).

3. Enter the IP address (refer to Section 4.4.1, Setting the Ether-
net address (IP address) of the Q.bridge, page 18) and use 
8010 for the Port. Enter 6 seconds or more for the 
Add.(itional) Timeout. Do not activate “Use scan for SNR”, 

http://www.gantner-instruments.com
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because, as delivered, all modules have a unique address 
(Fig. 5-1).

Abb. 5-1 Specifying the interface.

4. Start with File > Bus scan or click on  the interrogation 
of the modules connected to the bus coupler.

The modules found are displayed (Fig. 5-2). If not all modules 
are displayed, check whether the module RUN-LED is lit. If 
not, either the module is not correctly connected to the previ-
ous module or it is defective.

Abb. 5-2 Listing  the modules found.

The baud rate of all modules must be set to 12 MBd and must not 
be changed; refer also to Section 4.4.4, Setting the baud rate of 
the modules, page 21.

For configuration select from the list of modules the one you 
want. Then carry out all the module settings in the window that is 
then displayed.

You can also call several windows for several modules. The Win-
dows menu includes submenus to assign the individual windows.

5.1.3 Setting sensor parameters

In order to set parameters you should be connected to the mod-
ule and have called the configuration program ( which is started 
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automatically by ICP 100): For configuration select the module 
you want from the list of modules. Then carry out all the module 
settings in the window that is then displayed.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition.

Abb. 5-3 Dialog with the configuration for force transducers (6-
wire) and voltage input.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Analog. Input.

3. Click in the column Variable name and allocate a name iden-
tifying the signal from the connected sensor.

4. Click in the column Sensor and specify the type of sensor.

Depending on the type of module, you have various options 
available, e.g. Bridge for strain-gauge full and half-bridges, 
Pt100, Resistance for resistors or Voltage for voltage mea-
surements and IEPE sensors.

5. Click in the column Type of and specify the type of circuit or 
further information about the sensor type.

Depending on the selected sensor type, you have various 
options available, e.g. 2-wire or 4-wire (circuit) for resistive 
transducers or Full 4-wire or Full 6-wire (circuit) for strain-
gauge full bridges.

The column Wiring diagram shows you the pin assignment 
to be used. With more than one input the first inputs are also 
always occupied first (and first Plug 1, then Plug 2, etc.). 
Check that your sensor is connected correctly.

6. Click in the column Format/balance to enter the scaling for 
the sensor.
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Depending on the type of sensor selected, you have various 
options available (refer also to Section 7.3, Sensor scaling, 
page 101):

– For voltage signals specify the conversion of the measured 
voltage to the physical quantity measured by the sensor or 
output the measured voltage quantity without conversion 
(scaling).

– For thermocouples or Pt100 sensors no further scaling is 
required as the conversion into °C is made automatically. 
The scaling is only needed when you want to convert to °F 
or K. In this case enter the Unit (type into the field) and 
then click on Scaling. Using the method Factor and off-
set. For a display in °F enter the factor 1.8 and 32 as the 
offset. For a display in °K enter the factor 1 and -273.15 
as the offset.

– For full and half-bridge transducers you can obtain the 
data from the data sheet or (better) from the transducer 
calibration certificate. For a force transducer with, for 
example, 2.03mV/V at 5kN enter the Unit (type kN in the 
field) and then click on Scaling. Using the method 2-
point calibration. Enter in each case 0 for Point 1 for 
Measurement and Displayed value and 2.03 as Mea-
surement and 5 as Displayed measurement for Point 
2.

Alternatively, you can also enter N as Unit and then 5000 
as Displayed value for Point 2.

– For strain gauges you have the Strain gauge calculator 
available. Here, the unit is automatically changed to μm/
m. In the dialog enter the gauge factor of your strain 
gauge (left field) and the bridge factor (right field) for 
your circuit.

Floating point numbers are always transferred as 4-byte val-
ues and further setting is not necessary here.

For the formats Integer (2 bytes) and Long integer (4 bytes) 
specify the number of Decimal places and the total number 
of places to be output (Field length). The field length is cal-
culated including the points, but without any commas dis-
played for the thousands positions and it is only used for rep-
resentation in one of the Gantner programs. Specifying three 
decimal places displays, for example, the value 1234 as 1,234.

After closure of the dialog the number of transferred places 
and the unit are displayed in the column Format/balance, 
e.g. ff,fff.f [kN] for an output of a total of eight characters 
with two decimal places in the unit of kN and the decimal 
point.
If negative numbers occur, the display in this example is lim-
ited to -9,999.99 (eight characters without the comma).
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7. Click in the column Range/error to limit the admissible value 
range and to define the reaction in the case of an error 
(optional).

8. Also optionally, you can specify filtering of the sensor signal 
in the column Other.

9. Save the settings with File > Send to module or click on .

You can also save the settings in a file on the PC using File > 
Save to file so that you can load this configuration in the 
module again later.

5.1.4 Zero balancing/taring the sensor

You have two ways of setting a measurement offset to zero, e.g. 
due to preloads:

1. Zero balance

With this method measurement takes place over a certain 
time period and the mean is computed. This mean value is 
then subtracted from all the following measurements.

2. Taring

With this method the (single) measurement present at a cer-
tain point in time is subtracted from all the following mea-
surements.

Procedure 1. Click in the column Type of the first free row (V3 = Variable 3 
in Fig. 5-4) or mark the row (click on V3) and use Variable 
definition > Type.

2. Select Default.

3. Click in the column Variable name and allocate a name spec-
ifying the purpose of the signal, e.g. Zero_tare (Fig. 5-4).

Abb. 5-4 Defining the variable for zero balancing and/or taring.
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4. Click in the column Format/balance of the channel for which 
zero balancing and/or taring is to be executed, e.g. for the 
strain-gauge force sensor in Fig. 5-4.

Abb. 5-5 Dialog for sensor scaling.

5. Click on Zero balance or Tare to configure the relevant pro-
cess.

6. Select the variable created above as the control variable 
(Fig. 5-6).

Abb. 5-6 Setting up zero balance or tare.

When the variable (Zero_tare in this example) has certain values, 
taring or zero balancing is carried out or an existing zero or tare 
value is deleted (undo zero balancing/taring):

Value Function

1 Perform taring when setting the value

2 Reset tare (delete tare value)

4
Start zero balance The mean is formed until the value 0 
is written to the variable again.

8 Reset zero balance (delete zero value)
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5.1.5 Specifying digital inputs/outputs

In order to set parameters you should be connected to the mod-
ule and have called the configuration program ICP 100. For con-
figuration select the module you want from the list of modules. 
Then carry out all the module settings in the window that is then 
displayed.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition.

Abb. 5-7 Dialog with configuration for digital input and output.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Digit. input or Digit. output.

The column Wiring diagram shows you the pin assignment. 
With more than one input the first inputs are also always 
occupied first (first Plug 1, then Plug 2, etc.). Check for cor-
rect connection.

3. Click in the column Variable name and allocate a name iden-
tifying the signal.

4. At a digital output click in the column Type of and specify 
whether you want to use the output as Status indicator, Sta-
tus field or Process output. 

Process output: The output monitors a module signal and 
changes the output level under certain conditions. Click in the 
column Other and specify the type of alarm monitoring.

You can specify up to four alarm conditions. When one of 
the conditions is satisfied (logical OR), the alarm signal is 
triggered. 

To the left above the graphical displays select the levels at 
which switching is to occur and how they are to switch. 
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Enter the values for the switching thresholds in the 
(scaled) unit of the selected signal. Use either fixed values 
(constants) or arrange for the values to be determined by 
other variables.

Status indicator: The output can be set via a command from 
the EtherCAT master. Click in the column Other and specify 
the type of alarm monitoring.

5. Click in the column Format/balance to specify the transfer 
format.

Since digital signals do not require any Decimal places, you 
can enter 0 here. 1 is sufficient for the Field length. With a 
digital input you can also specify a unit (optional).

For several inputs/outputs and the type Status field (Type of 
column), as well as the transfer as a number (e.g. as integer), 
there is also the type Status field 32 with which all existing 
inputs or outputs are transferred as binary numbers. Define a 
suitable field length here depending on the number of inputs 
and outputs.

When the dialog is closed, the number of transferred places 
and the unit in the column Format/balance are displayed.

6. Click in the column Range/error to define the reaction in the 
case of an error for the digital outputs (optional).

7. Save the settings with File > Send to module or click on .

You can also save the settings in a file on the PC using File > 
Save to file so that you can load this configuration in the 
module again later.

5.1.6 Defining analog outputs

In order to set parameters you should be connected to the mod-
ule and have called the configuration program ICP 100. For con-
figuration select the module you want from the list of modules. 
Then carry out all the module settings in the window that is then 
displayed.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition.
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Abb. 5-8 Dialog with configuration for analog outputs.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Analog. Output.

The column Wiring diagram shows you the pin assignment. 
With more than one output the first outputs are also always 
occupied first (first Plug 1, then Plug 2, etc.). Check for cor-
rect connection.

3. Click in the column Variable name and allocate a name iden-
tifying the signal.

4. Click in the column Type of and specify whether you want to 
use the output as a Voltage or a Current output. 

5. In the Format/balance column the output format is shown 
which has no further significance here.

6. Click in the column Range/error to define the output scaling 
and the reaction in the case of an error (optional).

7. Click in the column Other to specify the signal source (vari-
able) used for the output.

8. Save the settings with File > Send to module or click on .

You can also save the settings in a file on the PC using File > 
Save to file so that you can load this configuration in the 
module again later.

5.1.7 Defining computations

In order to set parameters you should be connected to the mod-
ule and have called the configuration program ICP 100. For con-
figuration select the module you want from the list of modules. 
Then carry out all the module settings in the window that is then 
displayed.
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All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition.

Abb. 5-9 Dialog with configuration for a computation (V4).

Procedure 1. Click in the column Type of the first free row (in the illustra-
tion V4 = Variable 4) or mark the row (click on V4) and use 
Variable definition > Type.

2. Select Arithmetic.

3. Click in the column Variable name and allocate a name iden-
tifying the signal.

4. Click in the column Other and specify the required computa-
tion.

In the upper dialog field you can enter, as on a pocket calcula-
tor, a formula which uses the existing module variables. Cre-
ate functions via the buttons in the lower section of the dialog. 
Click on OK once you have defined the required computation.

5. Click in the Format/balance column to specify the transfer 
format using the formats Integer (2 bytes) and Long integer 
(4 bytes).

Floating point numbers are always transferred as 4-byte val-
ues and further setting is not necessary here.

For the formats Integer and Long integer specify the num-
ber of Decimal places and the total number of places to be 
output (Field length). The field length is calculated including 
the points, but without any commas displayed for the thou-
sands positions and it is only used for representation in one of 
the Gantner programs. Specifying three decimal places dis-
plays, for example, the value 1234 as 1,234.

After closure of the dialog the number of transferred places 
and the unit are displayed in the column Format/balance, 
e.g. ff,fff.f [N] for an output in the unit N with a total of seven 
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characters with one decimal place and the decimal separator.
If negative numbers occur, the display in this example is lim-
ited to -9,999.9 (seven characters without the comma).

6. Save the settings with File > Send to module or click on .

You can also save the settings in a file on the PC using File > 
Save to file so that you can load this configuration in the 
module again later.

5.1.8 Specifying the alarm monitoring

In order to set parameters you should be connected to the mod-
ule and have called the configuration program ICP 100. For con-
figuration select the module you want from the list of modules. 
Then carry out all the module settings in the window that is then 
displayed.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition.

➡ In order to monitor a limit and to output a level on a digital output 
when an alarm occurs, you can directly use the function of the 
digital output. You do not need to set up any alarm monitoring. 
The alarm monitoring is used to monitor signals in the module 
and to make the result available to the PC or PLC as a precondi-
tioned signal. Checking the original signal in the PC or PLC can 
therefore be omitted.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Alarm.

3. Click in the column Variable name and allocate a name iden-
tifying the alarm signal.

4. Click in the column Other and specify the type of alarm mon-
itoring.

You can specify up to four alarm conditions. When one of the 
conditions is satisfied (logical OR), the alarm signal is trig-
gered.

To the left above the graphical displays select the levels at 
which switching is to occur and how they are to switch. Enter 
the values for the switching thresholds in the (scaled) unit of 
the selected signal. Use either fixed values (constants) or 
arrange for the values to be determined by other variables.

5. Click in the column Format/balance to specify the transfer 
format.
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Since the alarm signal, like digital signals, does not require 
any Decimal places, you can enter 0 here. 1 is sufficient for 
the Field length.

When the dialog is closed, the number of transferred places 
and the unit in the column Format/balance, e.g. f, are dis-
played.

6. Save the settings with File > Send to module or click on .

You can also save the settings in a file on the PC using File > 
Save to file so that you can load this configuration in the 
module again later.

5.1.9 Firmware update

Recently purchased modules always contain the latest firmware, 
i.e. the software in the modules is the current version.

Please contact the Gantner Support (refer to Chapter 7, Func-
tional Procedures, page 95) if you have any further queries about 
this.



Vers. No. 1.0
82 Released: 13/4/2015

5     Configuration → Configuration via ICP 100



Q.series
Gantner Instruments GmbH 83

6     LabVIEW™ → The Q.series driver VIs

6 LabVIEW™

You have two ways of addressing the Q.bloxx modules with 
Q.bridge using LabVIEW™:

1. You use the Q.series driver VIs

This solution is primarily interesting if you already have exist-
ing LabVIEW™ applications which you want to expand or 
equip with new hardware.

2. You use the APPic Framework from APP Instruments

You can have APP Instruments produce a complete applica-
tion for you or you just use the framework. The advantage is 
that the framework already comes with the solution for many 
problems and includes numerous functions which go way 
beyond pure measurement operation. For example, you can 
execute functional libraries in the background, establish com-
munication between program sections, run program sections 
in parallel or establish communications amongst them 
through a network.

This chapter contains a description of the Q.series driver VIs and 
an explanation of the demo application which shows you how to 
use the VIs. It assumes that you are already familiar with 
LabVIEW™. Further information on LabVIEW™ can be found at 
www.ni.com from National Instruments Corporation.

6.1 The Q.series driver VIs

As usual in LabVIEW™, after activating the context help with a 
click on a VI or object, you obtain the explanation about its func-
tion and the inputs/outputs. Further information can also be 
found under www.ni.com/getting-started/labview-basics/d/prod-
uct-help.

6.1.1 Q.series_Initialize.vi

Abb. 6-1 VI for initialization.

The VI connects to the Q.bridge with the Target Address and 
switches it into the mode selected with Controller Mode. On 
selecting the Measurement mode the measuring rate (sample 
rate) is initialized in the default setting to 1000 Hz with a block 
size of 100.

The APPicLite output must be passed on to the next VI.

http://www.ni.com
http://www.ni.com/getting-started/labview-basics/d/product-help
http://www.ni.com/getting-started/labview-basics/d/product-help
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6.1.2 Q.series_Condition.vi

Abb. 6-2 Vi for reading out Q.bridge settings.

The VI reads the following four items of information into the 
string array Condition Info:

1. Baud rate

2. Mode (Measurement, Configuration or Transparent)

3. DAQ status (Idle, Init, Run or Deinit)

4. Error status (APPicLite error code)

The APPicLite Out output must be passed on to the next VI.

6.1.3 Q.series_Mode.vi

Abb. 6-3 VI for selecting the operating mode.

The VI switches the Q.bridge into the mode selected with Con-
troller Mode.

Use the VI to switch between the modes Measurement, Configu-
ration and Transparent in your application.

➡ The Transparent mode must be active so that other programs can 
connect to the Q.bridge.

The APPicLite Out output must be passed on to the next VI.

6.1.4 Q.series_ModuleLiveList.vi

Abb. 6-4 VI for detecting the connected modules.

The VI reads out the following parameters of all connected mod-
ules (Module Live List):

• Module address (in the default setting this corresponds to the 
position from the left in the system carrier; the first module 
adjacent to the Q.bridge has the address 1).

• Module manufacturer

• Module type

• Hardware version
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• Firmware version (software)

• Module serial number

The APPicLite Out output must be passed on to the next VI.

6.1.5 Q.series_ChannelLiveList.vi

Abb. 6-5 VI for detecting the existing channels.

The VI reads (again) from the modules specified in the Module 
Address which channels (variables) are defined. If you do not 
specify an address, all connected modules are read out. If you set 
Only from working modules? to True, only those modules are 
read out which have the same baud rate as the Q.bridge. The fol-
lowing parameters are output in the Channel Live List (two-
dimensional array):

• Module address (refer to Section 6.1.4, page 84)

• Variable name

• Variable type

• Data type of the variables

• Resolution/number of decimal places of the variables (preci-
sion)

• Unit of the variables

• Scaling factor and offset of the variables

• Channel resource, i.e. the channel “address”, consisting of 
the module address and position number of the channel in the 
module (Channel Resources in the Q.series_ResourceList.vi)

• Channel type, i.e. which type the channel or variable has. Cur-
rently there are three types: num_in for an input, num_out 
for an output and invalid for all other cases.

The array Channel List Headers (single-dimensional array) con-
tains the column names of the information items output in the 
Channel Live List.

The APPicLite Out output must be passed on to the next VI.
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6.1.6 Q.series_ResourceList.vi

Abb. 6-6 VI for defining all existing channels.

In the Q.bridge the VI generates the list of the assignments of 
existing channels (variables) of modules to the LabVIEW™ chan-
nels.

Channel Resources are all channels of all modules which are 
connected to the Q.bridge.
Channel Names are the names used for this in the LabVIEW™.
Channel Types defines whether the channel can be used as a 
pure input (num_in) or as an output (num_out).

Use the following VI Q.series_Getlist to transfer only certain 
channels during a measurement.

The APPicLite Out output must be passed on to the next VI.

6.1.7 Q.series_Getlist.vi

Abb. 6-7 VI for defining the required channels.

In the Q.bridge the VI generates the list of channels, the values of 
which are to be transferred. 

The AVI output must be passed on to the next VI.

Tip
The Q.bridge always contains all values of all channels of the con-
nected modules. Use Channels to read to select only the chan-
nels, the values of which are actually required. This reduces both 
the bandwidth required for the transfer as well as the CPU load.

6.1.8 Q.series_Samplerate.vi

Abb. 6-8 VI for defining the measuring rate (sample rate).
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The VI defines how often values are retrieved from the modules. 
You enter the frequency in Hz via the input Samplerate.

The APPicLite Out output must be passed on to the next VI.

6.1.9 Q.series_Start.vi

Abb. 6-9 VI for starting the data transfer.

The VI starts the data transfer or data output. You must however 
still use the VI Q.series_WaitForValidData before you can trans-
fer data, because the initialization phase of the Q.brixx modules 
must be awaited; refer to the following VI.

The APPicLite Out output must be passed on to the next VI.

6.1.10 Q.series_WaitForValidData.vi

Abb. 6-10 VI for awaiting the initialization phase of the modules.

The VI waits until the initialization phase of the Q.brixx module 
has finished and valid data are available from the channels (vari-
ables) specified in the Getlist VI. It is only after this that you can 
retrieve data with the VI Q.series_Read. If the channels specified 
by the VI Q.series_Getlist do not send data within the number of 
milliseconds specified at Timeout, the output Timeout? is set to 
True.

➡ Switching from the Configuration or Transparent mode to the 
Measurement mode may take up to 20 seconds, because the mod-
ules reboot.

The APPicLite Out output must be passed on to the next VI.

6.1.11 Q.series_Read.vi

Abb. 6-11 VI for reading the data.

The VI reads out the available data and is normally used in a loop. 
A two-dimensional array is output; for each channel there is one 
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row with the number of data items defined in Readblock. The 
data are transferred as 32-bit floating point values. 

The number of values still in the output buffer is given in Back-
log. The value should be smaller than the block size and not 
larger, because otherwise the transfer takes place too slowly and 
values are lost if the buffer overflows.

The APPicLite Out output must be passed on to the next VI.

6.1.12 Q.series_GetBacklog.vi

Abb. 6-12 VI for checking the output buffer.

This reads the number of values in the output buffer. The value 
should be smaller than the block size and not larger, because oth-
erwise the transfer takes place too slowly and values are lost if 
the buffer overflows.

The APPicLite Out output must be passed on to the next VI.

6.1.13 Q.series_Write.vi

Abb. 6-13 VI for writing data to the modules.

The VI writes the values defined in Channel Values to the output 
channels specified in Channel Names. The channels must be of 
the type num_out; refer to Q.series_ResourceList.vi.

The APPicLite Out output must be passed on to the next VI.

6.1.14 Q.series_Stop.vi

Abb. 6-14 VI for stopping the data transfer.

The VI stops the data transfer, also between modules and the 
Q.bridge.

The APPicLite Out output must be passed on to the next VI.
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6.1.15 Q.series_Clear.vi

Abb. 6-15 VI for terminating communication.

The VI resets the Q.bridge to the mode specified in the Controller 
Mode and terminates the communication (closes the connection). 
The default setting (no specification) is the Measurement mode.

IMPORTANT
The Transparent mode must be active so that other programs can 
connect to the Q.bridge.
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6.2 The demo applications

The demo applications do not use all the VIs possible. You can 
however easily follow the basic use of the VIs and their integra-
tion into an application.

To view and test one of the two examples open the project 
“Q.series Demo.lvproj” (Fig. 6-16).

Abb. 6-16 Opening a demo project.

Then in the “Demo” group double click either on Q.series-Demo_-
Configure.vi or Q.series-Demo_Simple.vi, depending on which 
example you wish to open.

6.2.1 Configuring Q.brixx modules with Q.bridge

For an application for the configuration of the active channels 
which are to be transferred from the Q.brixx modules via the 
Q.bridge you have to employ the VIs basically in the following 
sequence (the VIs are given in brackets):

1. Establish connection to the Q.bridge (Initialize.vi).

2. Switch the Q.bridge into the Configuration mode (Initial-
ize.vi).

3. Request the list of connected modules from the Q.bridge 
(ModuleLiveList.vi).

4. Request the list of the channels (variables) defined in the 
modules from the Q.bridge (ChannelLiveList.vi).

5. Reset the Q.bridge to the Transparent mode (terminate the 
task) and terminate the connection (Clear.vi).



Q.series
Gantner Instruments GmbH 91

6     LabVIEW™ → The demo applications

The example Q.series-Demo_Configure.vi shows the procedure. 
Enter the IP address of your Q.bridge (IP Address of Control-

ler) and start the VI with a click on  (Fig. 6-17). The con-
nected modules are shown in the upper field and the variables 
configured in the modules in the lower field.

Abb. 6-17 Demo VI for configuration.

Call the block diagram with Ctrl E to view the functional princi-
ple.
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6.2.2 Carrying out a measurement with the Q.brixx modules.

For a measurement application with the Q.brixx modules using 
Q.bridge you have to employ basically the VIs in the following 
sequence (the VIs and block diagram labels are given in brack-
ets):

1. Establish the connection to the Q.bridge and switch the 
Q.bridge into the Measurement mode (Initialize.vi, Create 
Task).

2. Set the list of channels (variables) to be transferred 
(ResourceList.vi, Create Channel).

3. Set the sample rate (Samplerate.vi, Samplerate).

4. Start the measurement (Start.vi, Start).

5. Wait until the modules are ready (WaitForValidData.vi, Wait 
for Modules).

6. Read in (and process) the data in a loop (Read.vi), Read Loop).

7. Stop the measurement at the end of the application (Stop.vi, 
Stop).

8. Reset the Q.bridge to the Transparent mode (terminate the 
task) and terminate the link (Clear.vi, Clear).

The example Q.series-Demo_Simple.vi shows the procedure. Pro-
ceed as follows to run the example:

1. Enter the IP address of your Q.bridge (IP Address Of Con-
troller).

2. Specify the channels to be displayed at Channels. The speci-
fication must use the same name as is shown in the Resource 
column in the example Q.series-Demo_Configure.vi; refer to 
Fig. 6-17.

3. Click on .
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Abb. 6-18 Demo VI for measurement.

Call the block diagram with Ctrl E to view the functional princi-
ple.

Click on STOP to terminate the VI.
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7 Functional Procedures

This chapter explains various important settings and processes 
more comprehensively than in the previous chapters, for exam-
ple, to provide you with decision-making aids for the interface 
parameters or the settings of the modules.

7.1 Ethernet on the PC

The following sections describe various settings which you can 
carry out on the PC to enable a link to be formed. The images use 
menus and dialogs found in Windows XP; the names of the dia-
logs and fields in other versions of Windows are however similar 
and are usually also given.

7.1.1 Finding the IP address and subnet mask of the PC

In Windows 7 or 8 open the Network and Sharing Center, e.g. 

using  at the bottom on the right in the taskbar. Click on the 
LAN connection (the name may be different) through which the 
Test Controller is connected to the PC (Fig. 7-1 on page 96). In 
the following status dialog (similarly in Fig. 7-1) click on Details.

The current address is displayed in the next dialog under IPv4 
address.

The subnet mask determines which addresses can be reached 
from the PC: Only addresses whose figures are identical in the 
places which contain a 255 in the subnet mask can be reached. 
The IP addresses of the PC and Test Controller should normally 
be located in the same Ethernet segment (only the last group of 
figures in the IP address is different), otherwise the subnet mask 
must be 255.255.0.0 so that the last two groups of figures may be 
different.
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Fig. 7-1 Viewing/changing the IP address of the PC

Example 1 Subnet mask 255.255.255.0, IP address 192.168.100.26

Only addresses can be reached which start with 192.168.100, i.e. 
the first three groups of figures must be identical and only the 
fourth may be different.

Example 2 Subnet mask 255.255.0.0, IP address 192.168.100.26

All addresses can be reached which start with 192.168, i.e. the 
third group of figures may also be different between the PC and 
Test Controller.

7.1.2 Setting the IP address on the PC

If you want to connect to a Test Controller, you must assign a 
(temporary) IP address to the PC.
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➡ We recommend that a temporary IP address is set up on the PC, 
because then the network settings on your PC for the normal con-
nections are not changed. If you have already set up this type of 
“alternative configuration” for another network, you must note 
the existing settings so that you can restore them after conclud-
ing the configuration of modules or the Test Controller.

In Windows 7 or 8 open the Network and Sharing Center, e.g. 

using  at the bottom on the right in the taskbar. Click on the 
LAN connection (the name may be different) through which the 
Test Controller is connected to the PC (refer to Fig. 7-1 on 
page 96). In the following status dialog click on Properties 
(requires administrator rights). Then mark Internet Protocol 
Version 4 and click on Properties (refer also to Fig. 7-2).

Then proceed to the register card Alternative Configuration 
and specify an address for the PC, e.g. 192.168.100.5, and a 
subnet mask, e.g. 255.255.255.0 (Fig. 7-3).

Fig. 7-2 LAN connection properties (Windows 7 and 8)
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Fig. 7-3 Specifying the IP address and subnet mask for an alterna-
tive (temporary) configuration.

7.1.3 Allowing access to network devices (firewall)

Generally, a firewall monitoring access of the PC to the network 
and vice versa is installed on the PC. Therefore, you must allow 
access to the Test Controller or the module, otherwise no connec-
tion can be established via Ethernet. On the first attempt to 
establish a connection you receive a message similar to that 
shown in Fig. 7-4. Click on Unblock to allow the connection.

IMPORTANT
You must possess administrator rights on the PC to be able to 
unblock the connection. If this is not the case, ask your adminis-
trator to do this for you. You must enable all programs for sharing 
which use an Ethernet connection to the modules or the Test 
Controllers.
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Fig. 7-4 Windows firewall message on attempting to establish an 
Ethernet connection.
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7.2 Connecting sensors with sensing leads

Resistive sensors require an excitation voltage to be able to pro-
vide their output signal. For sensor excitation a current is passed 
through the connecting lead, which however causes a loss of volt-
age due to the resistance of the connecting lead. Consequently, 
the sensor is then not supplied with the voltage set on the ampli-
fier module, but rather with a slightly lower voltage. This leads in 
turn to a lower output signal and, depending on the cable resis-
tance, losses in the single-figure percentage range can occur 
even with just a few meters. Therefore, high quality amplifier 
modules for the excitation of resistive sensors use so-called sens-
ing leads which can measure the loss of voltage, since only a very 
small current flows in them. This is because the inputs for the 

sensing leads have very high input resistances (usually over 106 
 compared to a sensor resistance of a few 100 . The amplifier 
module can therefore acquire the voltage arriving at the sensor 
error-free and increase its excitation voltage to compensate for 
the losses in the connecting cable. This is particularly the case 
when the temperature of the connecting cable changes. In this 
case the cable resistance changes and the sensor output signal 
would therefore also change if no sensing leads were used.

We therefore recommend the use of sensing leads. This is mainly 
necessary when several meters of cable are used, low measure-
ment deviations are to be obtained or when the temperature of 
the cable may vary.



Q.series
Gantner Instruments GmbH 101

7     Functional Procedures → Sensor scaling

7.3 Sensor scaling

Depending on the type of transducer (Sensor type), you have var-
ious possible scalings available. With voltage signals and strain 
gauge bridges (Bridge), you can define a conversion of the mea-
sured voltage (volts or mV/V) into a physical unit, e.g. in newtons. 
With strain gauges a special conversion tool is available to you.

Click in the column Format/balance of the variables to be set to 
call up the setup dialog (Fig. 7-5).

Fig. 7-5 Setup dialog for scaling.

7.3.1 Scaling of voltage signals and strain-gauge bridges

1. In the Unit field enter the required physical unit, e.g. N. 

If the unit has already been entered, you can select it from the 
list box.

2. Click on Scaling.

The scaling dialog is displayed.

3. Enter the transducer (sensor) data from the calibration certif-
icate or from the data sheet (example: refer to Fig. 7-6 on 
page 102).

Instead of the full scale readings in the positive and negative 
directions, you can also enter just one direction. Then in each 
case use 0 for Measurement and Displayed value at Point 
1.
An alternative is the entry of Factor and Offset if these data 
have been specified for your sensor.

The numbers in the Display field depend on the settings in 
the Range/error column.

4. Close the scaling and setup dialog with OK.
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Fig. 7-6 Scaling dialog

7.3.2 Scaling strain gauges

1. Click on Strain-gauge calculator, the unit is then automati-
cally changed to μm/m.

2. Enter the gauge factor of your strain gauge in the left field.

The gage factor is a measure of the sensitivity of the strain 
gauge and is stated on each strain-gauge pack. It is usually 
between 1.8 and 2.2. Fig. 7-7 shows scaling with k = 2.03.

3. If you are using more than one active strain gauge in your 
bridge circuit, you must also state the resulting bridge factor 
(right field). The factor depends on the orientation of the 
strain gauge on the measurement object and, where applica-
ble, also on the Poisson's ratio for the material. On a tension/
compression bar the bridge factor is, for example, approx. 
between 2.5 and 2.8 depending on the material. 

4. Close the scaling and setup dialog with OK.

Fig. 7-7 Scaling dialog for strain gauges.
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7.4 Current measurement with an external shunt

Current measurements are carried out by measuring the voltage 
drop across a resistance of known size (shunt resistance). In the 
Q.brixx modules, which are suitable for direct current measure-
ment, this is a resistor of 50 , with which you can measure cur-
rents up to 25 mA (the maximum shunt power dissipation is lim-
ited to 0.25 W). Higher currents need an external shunt which is 
looped into the line to be measured. The power dissipation occur-
ring at the current to be measured must be lower than the per-
missible power dissipation of the external shunt. In addition the 
voltages produced on the resistance must not exceed the permis-
sible input voltage on the analog input of the Q.brixx module. 
Configure the analog input as a voltage input and divide the mea-
sured voltage by Rext.

IMPORTANT
The error in the current measurement using an external shunt 
depends on the accuracy of the resistor used.
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7.5 Measuring with thermocouples

Thermocouples consist of two “thermoelectric wires” which are 
formed from different materials, e.g. platinum and platinum/rho-
dium, and are joined together at one end, usually by welding. If 
this contact point and the other ends of the thermoelectric cables 
have different temperatures, a “thermoelectric voltage” is pro-
duced at the contact point. This voltage is essentially propor-
tional to the temperature difference between the contact point 
and the ends of the cables.

Since thermocouples only measure a temperature difference (dif-
ference between the temperature at the contact point and the 
measured temperature at the terminal strip on the Q.brixx mod-
ule), the terminal temperature must be known or the “transition” 
from the thermocouple cable or compensating cable to the cop-
per cable must occur at a known temperature level. The first case 
is known as internal cold junction compensation (TCint) and the 

second case as external cold junction compensation, TCext.

To acquire the temperature with internal cold junction compen-
sation an additional temperature probe is used which measures 
the reference temperature. For the Q.brixx modules a cold junc-
tion compensation terminal with an integrated Pt1000 tempera-
ture probe is used. In this way, the temperature at the “transition 
point” is determined and the voltage produced by the thermocou-
ple is corrected depending on the type of thermocouple.

To measure the temperature using external cold junction com-
pensation, a second thermocouple of the same type is needed 
which is connected in series with the first one. The polarity is 
chosen such that the thermoelectric voltages subtract. The sec-
ond thermocouple is located at a fixed reference temperature 
(usually 0°C). Then, the Q.brixx module calculates the tempera-
ture at the measuring point based on the linearization curve. 
However, the Q.brixx module requires the information of which 
reference temperature (cold point temperature) is being used.
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8 International Sales and 
Service

The current addresses of our sales partners can be found in the 
Internet on our web site. You can take up direct contact with 
Gantner Instruments GmbH at any time.

You will find further information in the section Technical Infor-
mation in our Wiki at https://dev.gantner-instruments.com/doku-
wiki. The user name is support and the password is gins (not all 
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